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1. Related Manuals 
 
The table below lists the manuals related to this document.  
To ensure system safety, make sure to always read and heed the information provided in all 
Safety Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 
each device which is used in the system.  
 
Cat. No. Model Manual name 

W500 NJ501-[][][][] 
NJ301-[][][][] 

NJ-series CPU Unit Hardware User's Manual 

W501 NJ501-[][][][] 
NJ301-[][][][] 

NJ-series CPU Unit Software User's Manual 

W505 NJ501-[][][][] 
NJ301-[][][][] 

NJ-series CPU Unit Built-in EtherCAT Port User's 
Manual 

W504 SYSMAC-SE2[][][] Sysmac Studio Version 1 Operation Manual 
HMSI-168-101 ABX-[][][][]-ECTS User Manual Anybus X-gateway 
SP0736 ABX-[][][][]-ECTS Gateway Installation Sheet Anybus X-gateway 

HMSI-168-94 ABX-[][][][]-ECTS X-gateway Interface Addendum EtherCAT Slave 

SP0993 ABX-[][][][]-ECTS Network Installation Sheet 
EtherCAT Slave Interface 
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2. Terms and Definitions 
 

Term Explanation and Definition 
PDO communications 
(Communications using 
Process Data Objects) 

This method is used for cyclic data exchange between the master unit 
and the slave units.  
PDO data (i.e., I/O data that is mapped to PDOs) that is allocated in 
advance is refreshed periodically each EtherCAT process data 
communications cycle (i.e., the period of primary periodic task).  
The NJ-series Machine Automation Controller uses the PDO 
communications for commands to refresh I/O data in a fixed control 
period, including I/O data for EtherCAT Slave Units, and the position 
control data for the Servomotors.  
It is accessed from the NJ-series Machine Automation Controller in 
the following ways.  
•With device variables for EtherCAT slave I/O 
•With Axis Variables for Servo Drive and encoder input slave to which 

assigned as an axis 
SDO Communications 
(Communications using 
Service Data Objects) 

This method is used to read and write the specified slave unit data 
from the master unit when required.  
The NJ-series Machine Automation Controller uses SDO 
communications for commands to read and write data, such as for 
parameter transfers, at specified times.  
The NJ-series Machine Automation Controller can read/write the 
specified slave data (parameters and error information, etc.) with the 
EC_CoESDORead (Read CoE SDO) instruction or the 
EC_CoESDOWrite (Write CoE SDO) instruction.  

Slave unit There are various types of slaves such as Servo Drives that handle 
position data and I/O terminals that handle the bit signals.  
The slave unit receives output data sent from the master, and 
transmits input data to the master.  

Node address A node address is an address to identify a unit connected to 
EtherCAT.  

ESI file 
(EtherCAT Slave 
Information file) 

The ESI files contain information unique to the EtherCAT slaves in 
XML format.  
Install an ESI file into the Sysmac Studio, to allocate slave process 
data and make other settings.  
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3. Precautions 
(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing safety 
circuit in order to ensure safety and minimize risks of abnormal occurrence.  

(2) To ensure system safety, always read and heed the information provided in all Safety 
Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 
each device used in the system.  

(3) The user is encouraged to confirm the standards and regulations that the system must 
conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this 
document without the permission of OMRON Corporation.  

(5) The information contained in this document is current as of March 2014. It is subject to 
change without notice for improvement.  

 
The following notation is used in this document.  
 

 

Indicates a potentially hazardous situation which, if not avoided, 
will result in minor or moderate injury, or may result in serious 
injury or death. Additionally there may be significant property 
damage. 

 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury or in property damage. 

 

 Precautions for Safe Use 

Precautions on what to do and what not to do to ensure safe usage of the product.  

 

 Precautions for Correct Use 

Precautions on what to do and what not to do to ensure proper operation and performance.  

 

 Additional Information 
Additional information to read as required.  
This information is provided to increase understanding or make operation easier.  

 
 
Symbol 
  

 

The filled circle symbol indicates operations that you must do. 
The specific operation is shown in the circle and explained in text. 
This example shows a general precaution for something that must do. 
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4. Overview 
 

This document describes the procedure for connecting the Anybus X-gateway (hereinafter 
referred to as X-gateway) of HMS Industrial Networks (hereinafter referred to as HMS) to 
NJ-series Machine Automation Controller (hereinafter referred to as Controller) of OMRON 
Corporation via EtherCAT and provides the procedure for checking their connection. 
Refer to Section 6 EtherCAT Settings and Section 7. EtherCAT Connection Procedure to 
understand the setting method and key points to operate PDO communications of EtherCAT. 

 
 

5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 
The applicable devices are as follows:  
 

Manufacturer Name Model 
OMRON NJ-series CPU Unit NJ501-[][][][] 

NJ301-[][][][] 
HMS Anybus X-gateway ABX-[][][][]-ECTS 

 
 

 Precautions for Correct Use 

As applicable devices above, the devices with the models and versions listed in Section 5.2. 
are actually used in this document to describe the procedure for connecting devices and 
checking the connection.  
You cannot use devices with versions lower than the versions listed in Section 5.2.  
To use the above devices with versions not listed in Section 5.2 or versions higher than those 
listed in Section 5.2, check the differences in the specifications by referring to the manuals 
before operating the devices.  

 

 Additional Information 
This document describes the procedure to establish the network connection. Except for the 
connection procedure, it does not provide information on operation, installation or wiring 
method. It also does not describe the functionality or operation of the devices. Refer to the 
manuals or contact the device manufacturer.  
(HMS Industrial Networks  http://www.hms.se/) 
This URL is the latest address at the time of this document creation. Contact each device 
manufacturer for the latest information.  
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5.2. Device Configuration 

The hardware components to reproduce the connection procedure of this document are as 
follows:  
 

         
 
 
 
 
 
 
 

Manufacturer Name Model Version 
OMRON CPU Unit 

(Built-in EtherCAT port) 
NJ501-1500 Ver.1.06 

OMRON Power Supply Unit NJ-PA3001  
OMRON Sysmac Studio SYSMAC-SE2[][][] Ver.1.07 
- Personal computer 

(OS: Windows 7) 
-  

- USB cable 
(USB 2.0 type B connector) 

-  

OMRON Ethernet cable (with industrial 
Ethernet connector) 

XS5W-T421-[]M[]-K  

HMS Anybus X-gateway ABX-DEVS-ECTS Ver.3.20 
HMS Dedicated RS-232C cable (Included with Anybus 

X-gateway.) 
 

HMS ESI file ABXS_ECT_V_3_20_ 
Fixed_PDO_256bytes_ 
for_OMRON_1.xml 

Ver.1.2 

HMS Setup file 
•X-gateway and HyperTerminal 
 
*The following files are included: 
•hypertrm.dll 
•hypertrm.exe 

-  
•- 
 
 
•Ver.5.1.2600.2180 
•Ver.5.1.2600.0 

 

 Precautions for Correct Use 

Prepare the applicable ESI file described in this section beforehand. The ESI file can be 
downloaded from the HMS Industrial Networks website. 

http://www.hms.se/ 
Contact HMS Industrial Networks if the file is not available. 

 

USB cable 

Ethernet cable 

NJ501-1500 
(Built-in EtherCAT port) 

ABX-DEVS-ECTS 

Personal computer  
(Sysmac Studio and 
setup file 
installed, 
OS:Windows 7 ) 
 

Dedicated RS-232C cable 



5. Applicable Devices and Device Configuration 

 6 

 

 Precautions for Correct Use 

The connection line of EtherCAT communication cannot be shared with other Ethernet 
networks. 
Do not use devices for Ethernet such as a switching hub.  
Use the cable (double shielding with aluminum tape and braiding) of Category 5 or higher, 
and use the shielded connector of Category 5 or higher.  
Connect the cable shield to the connector hood at both ends of the cable.  

 

 Precautions for Correct Use 

Update the Sysmac Studio to the version specified in this section or higher version using the 
auto update function.  
If a version not specified in this section is used, the procedures described in Section 7 and 
subsequent sections may not be applicable. In that case, use the equivalent procedures 
described in the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

 Additional Information 
For specifications of the Ethernet cable and network wiring, refer to 4 EtherCAT Network 
Wiring of the NJ-series CPU Unit Built-in EtherCAT(R) Port User's Manual (Cat. No. W505). 

 

 Additional Information 
The system configuration in this document uses USB for the connection between the 
personal computer and NJ-series CPU. For how to install a USB driver, refer to A-1 Driver 
Installation for Direct USB Cable Connection of the Sysmac Studio Version 1 Operation 
Manual (Cat.No. W504).  
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6. EtherCAT Settings 
 
This section describes the specifications such as communication parameters and variables 
that are defined in this document.  
Hereinafter, X-gateway is referred to as the "Destination Device" or the "Slave Unit" in some 
descriptions. 
 

 Precautions for Correct Use 

This document checks if communications between the Controller and X-gateway are 
performed normally. Note that the communications data that are exchanged on EtherCAT are 
not checked. The data that are converted between EtherCAT and DeviceNet in the X-gateway 
are not checked, either. 

 
 

6.1. EtherCAT Communications Parameter Settings 
The communications parameters required to connect the Controller and the Destination 
Device via EtherCAT are given below.  
 
 X-gateway 
Node address 1 
Output PDO Size 256 bytes 
Input PDO Size 256 bytes 
 

 

 Additional Information 
For details on EtherCAT-related parameters for the X-gateway, refer to CANopen Object 
Dictionary Implementation of X-gateway Interface Addendum EtherCAT Slave 
(HMSI-168-94). 
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6.2. Allocation for PDO communications 

The EtherCAT PDO communications data of the Destination Device are allocated to the 
Controller's device variables. The Destination Device data, device variable names and the 
data types are shown below. 

 
■Output area (from Controller to Destination Device)  

Destination Device data Global variable Data type 
Receive PDO1 Mapping_ 
Output Byte 1_2100_01 

E001_Recieve_PDO_1_Mapping_ 
Output_Byte_1_2100_01 

USINT 

• 
• 
• 

• 
• 
• 

• 
• 
• 

Receive PDO1 Mapping_ 
Output Byte 128_2100_80 

E001_Recieve_PDO_1_Mapping_ 
Output_Byte_128_2100_80 

USINT 

Receive PDO 2 Mapping_ 
Output Byte 1_2101_01 

E001_Recieve_PDO_2_Mapping_ 
Output_Byte_1_2101_01 

USINT 

• 
• 
• 

• 
• 
• 

• 
• 
• 

Receive PDO 2 Mapping_ 
Output Byte 128_2101_80 

E001_Recieve_PDO_2_Mapping_ 
Output_Byte_128_2101_80 

USINT 

 
■Input area (from Destination Device to Controller)  

Destination Device data Global variable Data type 
Transmit PDO 1 Mapping_ 
Input Byte 1_2000_01 

E001_Transmit_PDO_1_Mapping_ 
Input_Byte_1_2000_01 

USINT 

• 
• 
• 

• 
• 
• 

• 
• 
• 

Transmit PDO 1 Mapping_ 
Input Byte 128_2000_80 

E001_Transmit_PDO_1_Mapping_ 
Input_Byte_128_2000_80 

USINT 

Transmit PDO 2 Mapping_ 
Input Byte 1_2001_01 

E001_Transmit_PDO_2_Mapping_ 
Input_Byte_1_2001_01 

USINT 

• 
• 
• 

• 
• 
• 

• 
• 
• 

Transmit PDO 2 Mapping_ 
Input Byte 128_2001_80 

E001_Transmit_PDO_2_Mapping_ 
Input_Byte_128_2001_80 

USINT 

 

 Additional Information 
For details on the I/O format, refer to Data Exchange of X-gateway Interface Addendum 
EtherCAT Slave (HMSI-168-94). 
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7. EtherCAT Connection Procedure 
 
This section describes the procedure for connecting the Controller to the X-gateway via 
EtherCAT. 
This document explains the procedures for setting up the Controller and the X-gateway from 
the factory default setting. For the initialization, refer to Section 8 Initialization Method.  

 
7.1. Work Flow 

Take the following steps to perform PDO communications of EtherCAT.  
 

7.2. Setting Up the X-gateway  Set up the X-gateway. 
↓   

 7.2.1. Parameter Settings  Set the parameters for the X-gateway. 
↓   

7.3. Setting Up the Controller  Set up the Controller.  
↓   

 7.3.1. Starting the Sysmac Studio and 
Installing the ESI File 

 Install the ESI file for the X-gateway in the Sysmac 
Studio. 

↓   
 7.3.2. Setting Up EtherCAT Network 

Configuration 
 Set up EtherCAT network configuration.  

↓   
 7.3.3. Setting the Device Variables  Set the device variables used for the EtherCAT 

Slave Unit.  
↓   

 7.3.4. Transferring the Project Data  Transfer the project data from the Sysmac Studio to 
the Controller.  

↓   
7.4. Checking the EtherCAT 

Communications 
 Confirm that the PDO communications of EtherCAT 

are performed normally.  
↓   

 7.4.1 Checking the Connection Status  Check the connection status of the EtherCAT 
network.  
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7.2. Setting Up the X-gateway 

Set up the X-gateway. 
 
7.2.1. Parameter Settings 

Set the parameters for the X-gateway. 
You set the parameters with "hypertrm.exe" HyperTerminal. Store and unzip the 
"X-gateway and HyperTerminal.zip" setup file beforehand that contains files necessary for 
parameter settings. 

 

 Additional Information 
For details on how to operate "hypertrm.exe" HyperTerminal, refer to Installation and 
Configuration of X-gateway Interface Addendum EtherCAT Slave and refer to Readme.pdf in 
the "X-gateway and HyperTerminal.zip" setup file. 

 

1 Make sure that the power supply 
to the X-gateway is OFF. 
 
* If the power supply is turned 
ON, settings may not be 
applicable as described in the 
following procedures. 

 

2 Connect the X-gateway and the 
personal computer with the 
dedicated RS-232C cable. 

 

X-gateway 

Dedicated RS-232C cable 
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3 Confirm that the following files 
are stored in the X-gateway and 
HyperTerminal setup file that 
was unzipped in the personal 
computer. 
•Hypertrm.dll 
•Hypertrm.exe 
 
*The Anybus X-gateway.ht file 
that is stored in the X-gateway 
and HyperTerminal setup file is 
not used in the procedure 
described in this document. 

 
Double-click hypertrm.exe to 
start up. 

 
 

 

4 Click the Yes Button if the dialog 
box on the right is displayed. 

 

5 The right dialog box is 
displayed. 
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6 Enter New Connection in the 
Name Field on the Connection 
Description Dialog Box and click 
the OK Button. 
 
*You can enter any name in the 
Name Field besides New 
Connection. The name that you 
entered here is not used in the 
following procedure. 

 

7 For Connect Using: on the 
Connect To Dialog Box, select 
the COM port of the personal 
computer to which the RS-232C 
cable is connected. 
 
 
 
 
 
 
 
 
 
 
 
*If the personal computer has 
multiple serial ports, display the 
Windows Device Manager and 
select the COM port number 
(COM1 in the example on the 
right) under Ports (COM & 
LPT).   

 
*To display the Device Manager, 
right-click My Computer, click 
Properties, click the Hardware 
tab, and then click Device 
Manager. 
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8 Make the Port Settings as 
follows: 

Bit per second: 57600 
Data bits: 8 
Parity: None 
Stop bits: 1 
Flow control: None 

 
After you make all of the 
settings, click the OK Button. 

  

9 Turn ON the power supply to the 
X-gateway. 

 

10 A message is displayed as 
shown in the figure on the right. 
 
Press the ESC Key. 

 

11 The menu shown on the right is 
displayed. 
 
Enter 6. 
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12 Enter y to the question shown 
on the right. 

 

13 A message stating “DeviceNet 
Slave (Upper)” is displayed as 
shown in the figure on the right. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Press the Enter Key until a 
message stating “EtherCAT 
slave (Lower)” is displayed as 
shown in the figure on the right. 
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14 Change the default value of 
Input PDO size (bytes): to 256 
bytes as shown in the figure on 
the right. 
 
Press the Enter Key after the 
value is changed. 

 

15 Change the default value of 
Output PDO size (bytes): to 256 
bytes as shown in the figure on 
the right. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After the value is changed, 
press the Enter Key until a 
question is displayed as shown 
in the figure on the right. 
 
Enter y to the question. 
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16 A question is displayed as 
shown in the figure on the right. 
 
Enter y to the question. 

 

17 After you complete the settings 
for the X-gateway, the window 
on the right is displayed. 

 

18 Select Exit from the File Menu. 

 



7. EtherCAT Connection Procedure 

 17 

19 The message on the right is 
displayed. Check the contents 
and click the Yes Button. 

 

20 If the message on the right is 
displayed, check the contents 
and click the No Button. 
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7.3. Setting Up the Controller 

Set up the Controller.  
 

7.3.1. Starting the Sysmac Studio and Installing the ESI File 
Install the ESI file for the X-gateway in the Sysmac Studio. 
Install the Sysmac Studio and USB driver in the personal computer beforehand.  
 

1 Connect the Ethernet cable to 
the built-in EtherCAT port 
(PORT2) of the Controller and 
connect the USB cable to the 
peripheral (USB) port. As shown 
in 5.2. Device Configuration, 
connect the personal computer, 
X-gateway and Controller. 

 

2 Turn ON the power supply to the 
Controller. 

 

3 Start the Sysmac Studio. 

 

4 Click the New Project Button.  
 
*If a confirmation dialog for an 
access right is displayed at 
start, select to start. 

  

USB cable 

CPU Unit 
 

End Cover 

Power Supply Unit 
Ethernet 
cable 
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5 The Project Properties Dialog 
Box is displayed.  
*In this document, New Project 
is set as the project name.  

 
Confirm that Category and 
Device that you use are set in 
the Select Device Field.  
 
Select version 1.06 from the 
pull-down list of Version.  
 
*Although 1.06 is selected in this 
document, select the version 
you actually use.  

 

 

 

6 Click the Create Button.  

 

7 The New Project is displayed.  
 
The left pane is called Multiview 
Explorer, the top right pane is 
called Toolbox, the bottom right 
pane is called Status Monitor 
Pane and the middle pane is 
called Edit Pane.  

 

8 Double-click EtherCAT under 
Configurations and Setup in 
the Multiview Explorer. 

 

Multiview 
Explorer 

Edit Pane 

Toolbox 

Status Monitor Pane 
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9 The EtherCAT Tab Page is 
displayed in the Edit Pane.  

 

10 Right-click Master and select 
Display ESI Library.  

 

11 The ESI Library Dialog Box is 
displayed. Click the this folder 
link.  
 
When the Explorer starts, close 
the dialog box by clicking the 
Close Button. 

 

12 The Explorer starts and a folder 
is opened allowing you to install 
the ESI file. Copy the prepared 
ESI file for HMS 
(ABXS_ECT_V_3_20_Fixed_P
DO_256bytes_for_OMRON_1.x
ml) to this folder. 
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13 Select Exit from the File Menu 
to exit the Sysmac Studio. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A dialog box is displayed 
confirming whether to save the 
project. If you do not need to 
save, click the No Button.  
 
*You need to restart the Sysmac 
Studio after installing an ESI 
file.  

 
 

 

14 Restart the Sysmac Studio by 
following steps 3 to 10 and 
display the ESI Library Dialog 
Box.  
 
Click the + Button of 
ABXS_ECT_V_3_20_Fixed_PD
O_256bytes_for_OMRON_1.xm
l to confirm that the 
Rev:0x00030014 device is 
displayed. 
 
Confirm that an exclamation 
mark (warning) is not displayed.  
 
Click the Close Button 

 
 

 Precautions for Correct Use 

If an exclamation mark (warning) is displayed for the ESI file, check the name of the ESI file 
and obtain the ESI file with a correct name. If an exclamation mark (warning) is displayed 
even when the name of the ESI file is correct, the file may be corrupted. Contact the device 
manufacturer.  
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7.3.2. Setting Up EtherCAT Network Configuration 

Set up EtherCAT network configuration. 
 

 

Always confirm safety before you reset the Controller or any components.  

 

 

1 Select Communications Setup 
from the Controller Menu. 

 

2 The Communications Setup 
Dialog Box is displayed. 
 
Select the Direct connection via 
USB Option for Connection 
Type.  
 
Click the OK Button.  

 

3 Select Online from the 
Controller Menu. 
 
 
 
 
A confirmation dialog box is 
displayed. Check the contents 
and click the Yes Button. 
 
*The displayed dialog depends 
on the status of the Controller 
used. Click the Yes Button to 
proceed with the processing.  

 
 

 

4 When an online connection is 
established, a yellow bar is 
displayed on the top of the Edit 
Pane.   
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 Additional Information 
For details on online connections to a Controller, refer to Section 5 Online Connections to a 
Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504). 

 

5 Select Mode - PROGRAM 
Mode from the Controller Menu.  

 

6 A confirmation dialog is 
displayed.  
Check if there is no problem and 
click the Yes Button.  
 
 
 
 
 
 
Confirm that the Controller 
Status in the Status Monitor 
Pane changed to PROGRAM 
mode. 

 
 

 

7 Right-click Master on the 
EtherCAT Tab Page of the Edit 
Pane, and select Write Slave 
Node Address.  
 
*If the EtherCAT Tab is not 
displayed on the Edit Pane, 
display it by following step 8 of 
7.3.1. Starting the Sysmac 
Studio and Installing the ESI 
File. 

 
 
 
 
A screen is displayed stating 
"Get information is being 
executed". 
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8 The Slave Node Address Writing 
Dialog Box is displayed. 
 
The present value (setting node 
address) and Anybus 
X-gateway-Slave 
Rev:0x00030014 are displayed 
in the Actual network 
configuration. 
 
*If the present value of the node 
address is 0,  and an error 
is displayed. 

 

9 Click the Set value field and 
enter 1 as the node address. 

 

 

10 Confirm that there is no error in 
the setting value and 1 is set.  
 
Click the Write Button. 
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11 The Slave Node Address Writing 
Dialog Box is displayed. Click 
the Write Button. 
 
 
 
 
A screen is displayed stating 
"Slave Node Address Writing is 
being executed". 
 
 
 
 
 
Then, a screen is displayed 
stating "Writing node addresses 
to slaves was successfully 
completed". 
Check the contents and click the 
Close Button. 

 
 

 
 

 

12 Cycle the power supply to the 
X-gateway. 

 

13 The EtherCAT Tab Page is 
displayed again. Right-click 
Master and select Compare 
and Merge with Actual 
Network Configuration. 
 
 
 
 
 
 
 
 
 
 
 
 
 
A screen is displayed stating 
"Get information is being 
executed". 
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14 The Compare and Merge with 
Actual Network Configuration 
Pane is displayed. 
Node address 1 and Anybus 
X-gateway-Slave 
Rev:0x00030014 are added to 
the Actual network configuration 
after the comparison. 
 
Click the Apply actual network 
configuration Button.   

15 A confirmation dialog box is 
displayed. Check the contents 
and click the Apply Button. 
 
 
 
A confirmation dialog box is 
displayed. Check the contents 
and click the Close Button. 
 
 
Confirm that node address 1, 
E001 and Anybus 
X-gateway-Slave 
Rev:0x00030014 were added to 
the Network configuration on 
Sysmac Studio. 
 
 
Click the Close Button. 

 
 

 

 
 

 

16 Node address 1, E001 and 
Anybus X-gateway-Slave 
Rev:0x00030014 are added to 
the EtherCAT Tab Page in the 
Edit Pane. 
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7.3.3. Setting the Device Variables 

Set the device variables used for the EtherCAT Slave Unit.  
 

1 Select Offline from the 
Controller Menu. 
 
 
 
 
 
The yellow bar on the top of the 
Edit Pane disappears. 

 
 

 

2 Double-click I/O Map under 
Configurations and Setup on 
the Multiview Explorer. 

 

3 The I/O Map Tab is displayed on 
the Edit Pane. 
 
Confirm that Node1 is displayed 
in the Position Column and the 
Slave Unit is displayed.  
 
*To manually set a variable 
name for the Slave Unit, click a 
column under Variable Column 
and enter a name.   

4 Right-click Node1 and select 
Create Device Variable.  
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5 The variable names and 
variable types are automatically 
set. 

 

 

 

 Additional Information 
The device variables are named automatically from a combination of the device names and 
the port names.  
For slave units, the default device names start with an "E" followed by a sequential number 
starting from "001". 

 

 Additional Information 
In this document, device variables are automatically named for a unit (a slave). Device 
variables can also be manually named for ports. 
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7.3.4. Transferring the Project Data 

Transfer the project data from the Sysmac Studio to the Controller.  
 
 

 
Always confirm safety at the Destination Device before you transfer a user 
program, configuration data, setup data, device variables, or values in memory 
used for CJ-series Units from the Sysmac Studio.  
The devices or machines may perform unexpected operation regardless of the 
operating mode of the CPU Unit.  

 

 

 Precautions for Safe Use 

After you transfer the user program, the CPU Unit restarts and communications with the 
EtherCAT slaves are cut off. During that period, the slave outputs behave according to the 
slave settings. The time that communications are cut off depends on the EtherCAT network 
configuration.  
Before you transfer the user program, confirm that the system will not be adversely affected.  

 
 

1 Select Check All Programs 
from the Project Menu.  

 

2 The Build Tab Page is displayed 
in the Edit Pane. 
 
Confirm that "0 Errors" and "0 
Warnings" are displayed. 

 

3 Select Rebuild Controller from 
the Project Menu. 

 

4 A confirmation dialog box is 
displayed. Confirm that there is 
no problem and click the Yes 
Button. 

 

5 Confirm that "0 Errors" and "0 
Warnings" are displayed in the 
Build Tab Page.  
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6 Select Online from the 
Controller Menu. 

 

7 Select Synchronization from 
the Controller Menu.  

 

8 The Synchronization Dialog Box 
is displayed. 
 
Confirm that the data to transfer 
(NJ501 in the right dialog) is 
selected. Then, click the 
Transfer To Controller Button. 
 
*After executing the Transfer To 
Controller, the Sysmac Studio 
data is transferred to the 
Controller and the data are 
compared. 
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9 A confirmation dialog box is 
displayed. Confirm that there is 
no problem and click the Yes 
Button. 
 
A screen stating "Synchronizing" 
is displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
A confirmation dialog box is 
displayed. Confirm that there is 
no problem and click the Yes 
Button. 

 

 
 

 
 

 

10 Confirm that the synchronized 
data is displayed with the color 
specified by "Synchronized" 
and that a message is displayed 
stating "The synchronization 
process successfully finished". 
 
If there is no problem, click the 
Close Button. 
 
*A message stating "The 
synchronization process 
successfully finished" is 
displayed if the Sysmac Studio 
project data and the data in the 
Controller match. 

 
*If the synchronization fails, 
check the wiring and repeat 
from step 1. 

 



7. EtherCAT Connection Procedure 

 32 

 
 

7.4. Checking the EtherCAT Communications 
Confirm that the PDO communications of EtherCAT are performed normally. 

 
 

7.4.1. Checking the Connection Status 
Check the connection status of the EtherCAT network. 
 

1 Check the LED indicators on the 
Controller and confirm that the 
EtherCAT communications are 
performed normally. 
 
LED indicators in normal status: 

[NET RUN]:Lit green 
[NET ERR]:Not lit 
[LINK/ACT]:Flashing yellow 

 

 

 

2 Check the LED indicators on the 
X-gateway.  
 
LED indicators in normal status: 

[L/A 1]: Flashing green 
[RUN]: Lit green 
[ERR]: Not lit 
[L/A 2]: Not lit 
[Gateway Status]: Lit green 
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3 Double-click EtherCAT under 
Configurations and Setup in the 
Multiview Explorer.  

 

4 
The  icon for E001 is 

displayed on the Edit Pane.  
 

Confirm that the  mark which 

indicates normal communications of 
EtherCAT is displayed.  

 

5 Select Troubleshooting from the 
Tools Menu. 

 

6 The Troubleshooting Dialog Box is 
displayed. 
 
Confirm that "No Error" is displayed 
on the Details Pane in the Controller 
Errors Tab. 
 
*A message stating "No Error" is 
displayed if there is no error in the 
EtherCAT communications. 

 



8. Initialization Method 

 34 

 

8. Initialization Method 
 
This document explains the setting procedure from the factory default setting.  
Some settings may not be applicable as described in this document unless you use the 
devices with the factory default setting.  

 
8.1. Initializing the Controller 

To initialize the settings of the Controller, select Clear All Memory from the Controller Menu of 
the Sysmac Studio. The Clear All Memory Dialog Box is displayed. Check the contents and 
click the OK Button.  
 

 
 
 

8.2. Initializing the X-gateway 
For how to initialize the X-gateway, contact HMS Industrial Networks.
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9. Revision History 
 

Revision 
code 

Date of revision Revision reason and revision page 

01 2013/8/8 First edition 
02 2014/3/4 Correction of device variable names for input area 

Correction of erroneous description 
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